
 

Introduction to the… 

Managed XP Service (For Students) 
M
B
D
A
 
© 

Contents 
ark Morley 
ob Booth 
ecember 2004 
P-Win7 

 University of Sheffield



Mark Morley / Bob Booth Student Managed XP Service  

 
1. INTRODUCTION ................................................................................................................................... 4 

2. USING A MANAGED SERVICE MACHINE ..................................................................................... 5 
2.1 LOGGING IN............................................................................................................................................... 5 
2.2 THE DESKTOP............................................................................................................................................ 6 
2.3 TERMINATING THE SESSION ...................................................................................................................... 7 

3. USING SOFTWARE............................................................................................................................... 8 
3.1 THE START BUTTON.................................................................................................................................. 8 
3.2 SOFTWARE AVAILABLE............................................................................................................................. 9 
3.3 PRINTING FROM SOFTWARE..................................................................................................................... 10 
3.4 MULTIMEDIA........................................................................................................................................... 11 
3.5 APPLICATION WINDOWS ......................................................................................................................... 11 

4. MANAGING YOUR ACCOUNT ........................................................................................................ 12 
4.1 SAVING FILES FROM WITHIN SOFTWARE................................................................................................. 12 
4.2 MY COMPUTER........................................................................................................................................ 13 
4.3 MY COMPUTER FOLDERS ........................................................................................................................ 14 
4.4 YOUR ACCOUNT AND OTHER DRIVES ..................................................................................................... 15 
4.5 ACCOUNT MANAGEMENT OPERATIONS................................................................................................... 16 
4.6 FILESTORE ALLOCATION & FREEZING..................................................................................................... 16 
4.7 CHANGING PASSWORD ............................................................................................................................ 17 
4.8 SYSTEM FILES ......................................................................................................................................... 17 
4.9 CREATING FOLDERS ................................................................................................................................ 17 
4.10 MORE FILE HANDLING TECHNIQUES....................................................................................................... 19 
4.11 WORKING WITH PORTABLE DISKS........................................................................................................... 20 
4.12 SEARCHING FOR FILES OR SOFTWARE ..................................................................................................... 20 

5. CONFIGURING YOUR DESKTOP ................................................................................................... 22 
5.1 FOLDER WINDOWS.................................................................................................................................. 22 
5.2 THE DESKTOP.......................................................................................................................................... 22 
5.3 THE TASKBAR ......................................................................................................................................... 22 
5.4 SHORTCUTS............................................................................................................................................. 22 

3 



Mark Morley / Bob Booth Student Managed XP Service  

1. Introduction 
In September 2003 CiCS rolled out a new service for University students, 
based on Windows XP and called the Managed Desktop Service. The service 
offers the latest 32 bit software, but prevents users from making serious 
changes to the machine set up. In this way we are able to offer all users a 
defined Desktop that they can make changes to, but which can be managed 
and upgraded centrally. 

This document introduces you to the Managed Desktop Service for students. It 
covers the basic Windows XP operating system and summarises the set-up and 
software at the University. Users of other modern Microsoft operating systems 
will notice limitations to the service, compared to personal machines. These 
restrictions serve to keep the system centrally manageable, without 
significantly inconveniencing the individual user.  
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2. Using a Managed Service Machine  
To use a CiCS Managed Desktop Service PC you will need to be registered to 
use the computer systems, and have your own username and password. 

2.1 Logging In 

When you arrive at a machine in a student computing room, you may find it in 
one of three states: 

• 
• 

• 

If the machine is switched off, start from step 1 below. 

If the machine is displaying a Novell Login dialog, proceed from step 2 
below. 

If the machine is in any other state, switch the machine off then proceed 
from step 1 below. 

1. First ensure there are no disks in the floppy or zip disk drives, and then 
switch your machine on.  

2. You will then see the Novell Login dialog.  

Type your username in the Username field, then press the Tab key or use 
the mouse cursor to move to the Password field and type your password 
in here. Finally, either press the Enter key or click the OK button. The 
dialog box will remain on screen for a while, but the cursor will change to 
represent a network login process. After a short time you will be logged 
onto the system and the Windows Managed Desktop will load. 

If the login procedure fails, click the Cancel butons until you return to the 
Novell Login screen. Repeat the login procedure. 
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2.2 The Desktop 

On the Managed Desktop Service you will see some icons and the grey 
Taskbar, containing the Start button, running along the bottom of the screen. 

 

My Documents is the default folder used by software for storing your files. 
This icon gives you quick access to your files. 

The My Computer icon lets you access the files and folders on your hard disk 
and on network drives. 

Internet Explorer, commonly called IE, is the standard web browser used at 
the Univeristy. 

Load Application Menus allows you to load the Applications onto the Start 
menu. These applications have been installed by the University for your 
studies. You only need to run Load Applications once, and Applications 
appears at the top of the Start menu. You can run Load Applications from this 
icon or from the Start menu. 

Windows Media Player allows you to play media files like audio and moving 
images, as well as playing audio CDs. 

The Shredder replaces the Recycle Bin found on most Windows Desktops. 
This provides a drag and drop mechanism for deleting files, but unlike the 
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Recycle Bin, once files have been deleted they cannot be recovered, so use the 
Shredder with caution.  

The Start button brings up the Start menu and gives you access to all the 
software on the computer, to various configuration tools, and to printers. 

The Taskbar displays all applications that are active and allows you to quickly 
switch between running applications. 

2.3 Terminating the Session 

When you have finished using your machine do not switch it off. You need to 
shut it down securely by clicking on the Start button and selecting Shut 
Down… You will get a dialog box.  

 

From the drop-down menu, select Log off your username. Then click OK. 
This will log you off from the network, and leave the computer ready for the 
next person to log on. 
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3. Using Software 

3.1 The Start Button 

All software is available through the Start button. If you click the Start button 
the Start menu will appear. Most of the entries on the Start menu have small 
arrows beside them. If you click any of these entries you will see a sub-menu 
similar to that shown below. 

 

In this image, the Applications item has already been installed using the Load 
Applications Menus (refer to The Desktop section above for details). 

To use any piece of software, click the Start button, then locate the entry from 
the menu. The general Windows software, including Microsoft Office, is 
under the Programs menu. Subject specific software is stored under the 
Applications menu. 

When you click on the software entry the Start menus will disappear and the 
software will load. The first time you start the software on a machine you may 
have to wait a few minutes whilst it is downloaded from the server. Once you 
have downloaded any piece of software it will load very quickly for all 
subsequent sessions. 

You may be used to starting software by using shortcuts, or by opening 
documents either from the Documents menu or from My Computer. While 
these do work in most cases there can be unpredictable effects when software 
is upgraded, and you may lose any changes that you had made to the 
configuration of the software. It is always safest to start software from the 
Start menu. 
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3.2 Software Available 

This section outlines the most popular software available on the Managed 
Desktop Service. 

Internet Explorer 

Start Internet Explorer (IE) from the Desktop icon or from the Start menu; 
Programs. 

IE loads the University homepage. You can type in web addresses into the 
address text entry box or click on links to load new web pages. 

Many services are provided by the University to you over the web, including 
MUSE, Webmail, and facilities to manage your account like changing your 
password. 

Word XP 

Start Word XP using the Start menu; Programs. Avoid starting it by 
activating document icons or using My Documents.  

Type text into the white area and use the menus and toolbars to apply 
formatting. Advanced users can create personal macros, templates and 
toolbars, and use the installed wizards. 

Excel XP 

Start Excel XP using the Start menu; Programs. Avoid starting it by 
activating workbook icons or using My Documents. 

Type data into the cells and use the menus and toolbars for processing. 
Advanced users can create personal macros, templates and toolbars, and use 
the installed wizards. 

Access XP 

Start Access XP using the Start menu; Programs. Avoid starting it by 
activating database icons or using My Documents.  

First define the fields in your tables, then enter data and set up links. 
Advanced users can create personal macros, templates and toolbars, and use 
the installed wizards. 

Virus Scanning 

The McAfee virus scanner runs on the Managed Desktop Service constantly 
looking for viruses and keeping you safe. If you wish to double-check you can 
run VirusScan to check a file or floppy disk for example, it is available from 
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Programs>Network Associates>VirusScan On-Demand Scan. You can then 
choose the drives or disks you want to scan using the Add… button followed 
by the Scan Now button. A window pops-up and the scan commences. 

X Software 

The Exceed X client allows graphical access to remote computers so that you 
can use the graphical systems on Unix supercomputers and workstations. It is 
available from Applications>Unix Connectivity>Exceed 3D. 

Telnet  

Telnet software allows you to control a remote computer from your own PC. It 
is often used to access supercomputers or mainframes. The Telnet client 
supplied on the Managed Desktop Service is the Exceed client and is available 
from the Start menu, under Applications. When you start the software you 
will get a dialog into which you should type the address of the host. Select VT 
as the access type, and then click the OK button to access the host. A window 
will open for the host machine and you can log in as usual. 

Also available is the Microsoft Telnet client. 

FTP Client 

FTP clients allow you to transfer files between your computer and a remote 
machine. The Managed Desktop Service offers the Smart FTP client, available 
from Applications>Unix Connectivity. You can type in the machine address 
you wish to ftp to and you are presented with separate windows for your 
computer and for the remote machine. Files can be dragged between windows 
to transfer them between machines.  

File Compression 

Files and software are often distributed in the ZIP compression format (not to 
be confused with Zip drives). The compression software Zip Central is 
available under Applications>Utilities. To open an existing archive click the 
Open button, to create an archive of your files click the New button. 

3.3 Printing from Software 

Most student computing rooms on campus are provided with a networked 
printer. When you log in to a computer in any room, you will have the choice 
of three printers HP 4100, HP 8500 or HP Colour Printer. Printing from any 
software will then send work to the appropriately chosen network printer. 
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3.4 Multimedia 

All Managed Desktop Service machines are equipped with CD drives and 
soundcards. This means you can download and play sound from web pages, 
run software or load data from your own CD-ROMs, or have music CDs 
playing while you work.  

In order to use sound you need to obtain your own headphones, which you 
plug into the front of the computer base, below the table. 

3.5 Application Windows 

Any running software is contained in its own window so that, for example, 
Word and Internet Explorer can be run within separate windows on your 
Desktop.  

Windows can be moved, resized, maximized and minimized. If you point at 
any border of the window the arrow will change to a double-headed arrow. 
With this you can drag the border of the window to increase or decrease its 
size in either direction. Additionally, if you point at the bottom right corner of 
the window you can resize the window diagonally. 

Clicking on the Close button will close down the window. In an application 
window this will close down the application itself. 

Clicking on the Maximize button will expand the window to fill the entire 
screen. The maximize button will be replaced by a Restore button. 

Clicking on the Restore button will return a maximized window to its original 
size. 

Clicking on the Minimize button will make the window disappear from the 
Desktop. In an Application window this will make the application disappear, 
but will not close it down. When you minimize a window it vanishes to the 
Taskbar. 

To reinstate a window that has been minimized you should click on its entry in 
the Taskbar. You can also use the Taskbar to switch between application 
Windows. Or you can use the Alt and Tab key combination to switch between 
running tasks. All running tasks are displayed as icons and repeatedly pressing 
the Tab key whilst holding down Alt moves you between applications. 
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4. Managing Your Account 
Each piece of work that you do on a computer will be saved into a file. During 
your studies at the University you will produce many, many, computer files. 
Each file will have a name, and will be saved into your account. You should 
never save a file directly onto a floppy or zip disk. 

Your account is organised into a series of folders, most of your files will go 
into the My Documents folder. You can, however, save files anywhere within 
your account, and create your own system of folders. 

4.1 Saving Files from Within Software 

When you save a file from any software on the Managed Desktop Service you 
will get a standard dialog box. At the top there is a Save in field, which will 
display the folder hierarchy of all the drives on your computer. Below this 
there will be a list of the files contained in the current folder.  

 

To save a file, type a name into the File name field. The name can be up to 
256 characters, use mixed case letters, and can include spaces. Then click on 
the Save button.  

The following two buttons let you choose or create a suitable folder for the 
file.  

Takes you up the hierarchy one folder at a time. This can be much more 
convenient than repeatedly using the Save in field. 

Allows you to create a new folder for the file. This simple tool makes it 
much easier for you to develop a well-managed folder structure. 
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4.2 My Computer 

Having created a series of files, you will need to be able to locate and manage 
them. The My Computer icon on the Desktop lets you examine the contents of 
all the drives on your computer, including your network account. It displays 
each folder as a separate window and the folder contents are displayed as 
icons. 

To browse your computer, double-click the My Computer icon. A window 
will open displaying icons for the drives and printers of your computer. To 
look at the contents of any drive double-click its icon. A second window will 
open displaying icons for the files and folders on that drive. You can then 
proceed to open new windows for any folder you encounter until you find the 
file you are looking for. You can retreat back through the folder hierarchy by 
pressing the Backspace key repeatedly or clicking the Up button if you have 
the Toolbar displayed. 

 

To access your account you should double-click the drive that is labelled by 
your username. In the example above it is Cs1mjm. 
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4.3 My Computer Folders 

My Computer Folders lets you view the folder hierarchy of your computer. 
Start My Computer (as above) and then click on the Folders icon. 

 

The left-hand window displays the drives and folders on your computer. 
Clicking on any plus symbol will expand that folder so that all folders within 
it will be displayed in the left-hand window. Clicking on a minus symbol will 
collapse that part of the tree structure, so that only the parent folder is 
displayed.  

The right hand window displays the contents of the current folder. To display 
the contents of a different folder, click that folder in the left-hand window or 
double-click it in the right.  
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4.4 Your Account and Other Drives 

Using My Computer or My Computer Folders reveals an impressive array of 
drives available to you, these are summarised below. 

• 

• 

• 

• 

• 

The floppy disk drive is in every machine. You can backup important files 
onto your own floppy disk.  

The hard disks of the machine are where the operating system and 
software is installed. You will not be able to save files onto the hard disks. 

The zip drive is labelled Removable Disk, and is available on some 
machines. You can backup important files onto your own zip disk, which 
has more storage capacity than a standard floppy disk. 

The CD drive is available on all machines. You can load data or run 
software from your own CD-ROMs or have music playing through your 
headphones while you work. 

Lots of network drives with long names. These are network connections 
that ensure all machines have access to all necessary components of the 
operating system, network and software. 

However, the most important drive is your account, labelled by your username 
and given the drive letter U:. In this account you can hold files up to your 
filestore limit. You can access these files from any Managed Desktop Service 
machine around the University.  
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4.5 Account Management Operations 

You manage your account via the web at 
http://www.shef.ac.uk/cics/password/ 

For security, you have to login to your account management pages using your 
usual username and password and clicking the Login button. You will then see 
a screen similar to: 

 

Once you have finished with Account Management operations, you must click 
Logout to make the environment secure. 

4.6 Filestore Allocation & Freezing 

Each person is allocated a quota of file storage space for drive U. Every time 
you use your machine the system checks whether you are within your quota. If 
you exceed your quota you can continue to work and save more files onto 
drive U temporarily. However, if you do not reduce your filestore to within 
your quota your account will become frozen and software won’t run correctly. 

If this happens you should check your filestore by clicking option 1 in your 
Account Management. Your quota is displayed and the amount of space being 
taken up so you will know how much space you will need to free up. You will 
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need to start My Computer or My Computer Folders. Browse you computer 
and locate files that you do not need to use regularly. Move these files onto a 
floppy disk, or zip disk for storage. Repeat this until you have removed 
sufficient files to bring your account within its quota. Then click option 2 in 
your Account Management to Unfreeze your account. 

4.7 Changing Password 

The initial password that you receive when you register is very secure, but 
difficult to remember. If you wish to change your password you can do so 
easily. Click option 3 in Account Management. You simply type in the old 
password and then the new and click Change. 

As new services are released, you may be asked to synchronise your 
passwords to make them the same to you can access the new service. This can 
be done via option 4. 

4.8 System Files 

Contained on your drive U will be some system files. An interesting system 
folder is the OfficeXP folder. This contains a sub-folder called My 
Documents. If you are storing your work files on drive U then it is 
recommended that you use the My Documents folder as your parent folder for 
work files. By default most software will suggest that you save your files in 
the My Documents folder. 

4.9 Creating Folders 

Using My Computer or My Computer Folders 

To create a folder in your account, use My Computer or My Computer Folders 
to display the location for the new folder, then from the File menu select New, 
and from the sub-menu select Folder. 

A folder will appear in the window and it will have the name New Folder. If 
this name is already selected, type in a new name for the folder and press the 
Enter key. If the name is not selected click the folder then click its name to 
select it. You can then type in a new name and press Enter. 
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You can then open this folder by double-clicking it. Once inside the new 
folder you can create files or create more new folders to build your file storage 
structure. 

Moving Files between Folders 

An easiest way to move files between folders is to drag the file from one place 
to another. To do this you need to have both the current location and 
destination of the file visible on screen together. Using My Computer this 
means having two windows open, one containing the file, the other containing 
the destination folder. Using My Computer Folders this means having the file 
displayed in the right-hand window and having the folder structure on the left 
expanded to reveal the destination folder. 

To transport the file you should then click the file with the right mouse button, 
and keep this button pressed down. With the right-button still pressed, you 
should move the mouse over to the destination folder and release the button. A 
pop-up menu will then appear asking if you wish to copy, move or create a 
shortcut for the file 

 

 

 

• 

• 

• 

If you choose Copy 
Here, the file will be duplicated in the destination folder, leaving the 
original version untouched, making two copies of the same file. 

If you choose Move Here, the file will be transferred to the destination 
folder, and the original version will be removed, making a single copy of 
the file in a new location. 

If you choose Create Shortcuts Here the original file will remain in its 
current location and will not be duplicated. Instead a convenient shortcut 
to the file will be created in the destination folder. Whenever this shortcut 
is activated you will be taken to the existing file. 

So choose the most appropriate option. This should usually be Move Here, as 
making too many copies will clutter your account and may result in different 
versions of the same file being edited concurrently. 

Deleting Files 

One way to delete a file in My Computer is to click on the file to select it then 
pull down the File menu and select Delete. 

A dialog will appear asking if you really wish to delete the file. If you click 
the Yes button the file will be deleted. 
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Desktop Files 

You may be used to placing important files on your Desktop for easy access, 
however, as we have emphasised, it is always safest to start software from the 
Start menu. So, use the Desktop to store files by all means, but do so 
cautiously. 

4.10 More File Handling Techniques 

Two ways to copy or move a file from one place to another: 

• Highlight the file and in the left-hand menu File and Folder Tasks select 
Move this file or Copy this file. A dialog opens containing a folder 
structure. You select the folder to move/copy the file to and click the 
Move or Copy button.  

• Have windows open for each drive and drag the file across with the left 
mouse button. If the folders are on the same drive dragging will move the 
file, if they are on different drives dragging will copy the file. Holding the 
Shift key down whilst dragging will toggle between move and copy. 

Three ways to rename a file: 

• Select the file, and then select Rename from the File menu of the folder. 
The name below the icon will become highlighted and you can enter a new 
filename. 

• Right-click the file, then select Rename from the pop-up menu. The name 
will become highlighted and you can enter a new filename. 

• Click on the file twice (not double-click but with a pause in between). The 
name is highlighted and you can enter a new filename. 

Two ways to delete a file: 

• Select the file then press the Delete key. 

• Drag the file to the Recycle Bin, if visible. 

Four ways to select multiple files: 

• Select the first file, and then hold down the Shift key whilst you select the 
last file. All files in-between will become selected. This only works for 
sets of consecutive files. 

• Hold down the Ctrl key whilst selecting individual files.  
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• When you have a folder displayed in a window you can select a block of 
files by dragging a box around them with the mouse. You can add to this 
block by holding down Shift as you drag out additional blocks. 

• To select all files in a folder choose Select All from the Edit menu, or 
press Ctrl and A 

4.11 Working with Portable Disks 

Although you should save your files into your account, this has a finite 
amount of space. If you begin to run out of space you should copy old work 
onto your own disks, which you should store in a safe place. Once you have 
copied them, delete the old files from drive U to release some space. 

All the machines running the Managed Desktop Service will have 3½ floppy 
disk drives; in addition many machines will also have zip disk drives. Zip 
disks are portable disks with a high storage capacity. The zip disks installed on 
these machines work with 100 MB zip disks, which are available to buy from 
the IT Centre counters. 

Sometimes, disks need to be formatted. Most new disks are already formatted 
when bought, but you may choose to reformat an old disk to make it as good 
as new. To format a portable disk, insert it into its drive, and then right click 
on that drive in My Computer. From the menu, select Format…  Be careful 
not to inadvertently format an important disk, as formatting irretrievably 
removes all files on a disk. 

Once you have a formatted disk you can copy or move work files onto it. 

• To copy or move a file to disk using My Computer, open drive U, 
highlight the file and then from the File and Folder Tasks options select 
either Copy this file or Move this file. A Copy Items or Move Items 
window opens with a folder structure shown. Simply select the disk drive 
(A: for floppy) and click the Copy or Move button. Alternatively, open a 
window for both your drive U and for the disk, then drag the file from one 
window to the other to copy. 

• To copy a file to disk using My Computer Folders have drive U displayed 
on the right, and then drag the file onto the disk drive on the left hand 
folder tree. 

4.12 Searching for Files or Software 

If you cannot locate an important piece of work you can always get Windows 
to search for it. 
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Click the Start button and select Search, then from the sub-menu select All 
Files or Folders. Enter a word or phase that appears in the name of the file 
required and select the drive to be searched. Then click the Search button. The 
computer will generate a list of files matching your criteria. Locate your file in 
the list, and if it is in an inappropriate place, move it to somewhere easier to 
find. 
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5. Configuring Your Desktop 
Once you are comfortable using the Managed Desktop Service you might like 
to change your standard Desktop to reflect your preferences and the way that 
you work. You can change the layout of the Desktop, change how your files 
are displayed, and in some cases add convenient shortcuts to specific software 
and documents.  

5.1 Folder Windows 

You can change the way in which file are listed in My Computer. From the 
View menu, you can choose to have files displayed as small icons, in a list, or 
with all details. Also from the View menu you can choose whether to have 
handy Toolbars displayed in the Window.  

5.2 The Desktop 

On your computer you can change the background colour, the Desktop fonts, 
and make many other changes. To do this, right-click the Desktop and from 
the pop-up menu select Properties. You will get a dialog box with tabs for 
Themes, Desktop, Screen Saver, Appearance and Settings. Flick through 
these, making changes as you require. When you are finished, click the OK 
button. 

5.3 The Taskbar 

You can move the Taskbar to any edge by dragging it with the left mouse 
button. You can make the Taskbar wider by holding the mouse over its edge 
and dragging it wider. You can right-click the Taskbar and select Properties 
to implement the AutoHide function. 

5.4 Shortcuts 

Shortcuts are convenient pointers to important components. If, for example, 
you had all your files in a single folder, you might place a shortcut to the 
folder on your Desktop so that you can access your important files quickly by 
double-clicking the Desktop shortcut. 

To create a shortcut, locate a file or folder using My Computer, and then drag 
it onto the Desktop using the right mouse button. When you then release the 
button a pop-up menu will appear from which you should select Create 
Shortcuts Here. 
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On the Managed Desktop Service it is advised not to use shortcuts to quickly 
start software. It the software version has changed, or the machine you are 
using has recently been reset you may not be able to access the software this 
way, and even if you can you may lose any changes you had made to your 
toolbars and templates. 
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